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PreSonus be liable for incidental, consequential or other damages resulting from the breach of any 
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inconvenience or on loss of use of the product, and, to the extent permitted by law, damages for 
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legal rights, and you may also have other rights, which vary from state to state.  This warranty only 
applies to products sold and used in the United States of America.  For warranty information in all 
other countries please refer to your local distributor. 
 
 
 
PreSonus Audio Electronics, Inc. 
7257 Florida Blvd. 
Baton Rouge, LA 70806 
www.PreSonus.com



TABLE OF CONTENTS 
 

 
 

© 2008, PreSonus Audio Electronics, Inc. 
All Rights Reserved. 

1  OVERVIEW 

1.1  Introduction  ................................................................................  3 
 1.2  Features  ......................................................................................  4 
 1.3  What is in the Box  .......................................................................  5 
 1.4  System Requirements  ..................................................................  6 
 
2  OPERATION 

2.1  Quick Start Up  ............................................................................  7 
2.1.1  Installation in Microsoft Windows  ....................................  7 

 2.1.2  Installation in Mac OS X  ..................................................  7 
2.1.3  Cubase LE – Device Setup  ................................................  9 
2.1.4  Cubase LE – Creating a Project  ........................................  11 

2.2  Sample Hookup Diagram  .............................................................  13 
2.3  Microphones  ...............................................................................  14 

2.3.1  Condenser  ........................................................................  14 
2.3.2  Dynamic  ..........................................................................  14 
2.3.3  USB and other types  ........................................................  15 

 
 
3  HARDWARE OVERVIEW 

3.1  Front Panel Layout  ..................................................................... 16 
3.2  Back Panel Layout  ...................................................................... 18 
 
 

4  TECHNICAL INFORMATION 

4.1  Specifications  .............................................................................. 19



OVERVIEW 
 

 
3 | PreSonus 2008 

1.1  INTRODUCTION 

 
 
Thank you for purchasing the PreSonus AudioBox USB. PreSonus Audio Electronics has designed 
the AudioBox USB utilizing high-grade components to ensure optimum performance that will last a 
lifetime.  Loaded with 24-bit 48kHz converters, two PreSonus microphone preamplifiers and Cubase 
LE 48-track music production software, the AudioBox USB is ready to go out of the box for 
professional quality computer recording.  All you need is a computer with USB connection, a couple 
of microphones and cables along with your instruments and you are ready to record! 
 
We encourage you to contact us at 225-216-7887 or techsupport@presonus.com with any questions 
or comments you may have regarding your AudioBox USB.  PreSonus Audio Electronics is 
committed to constant product improvement, and we value your suggestions highly.  We believe the 
best way to achieve our goal of constant product improvement is by listening to the real experts, our 
valued customers.  We appreciate the support you have shown us through the purchase of this 
product.   
 
We suggest you use this manual to familiarize yourself with the features, applications and correct 
connection procedure for your AudioBox USB before trying to connect it to your computer.  This will 
hopefully alleviate any unforeseen issues that you may encounter during installation and set up.  
 
Thank you, once again, for buying our product, and we hope you enjoy your AudioBox USB! 
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1.2  FEATURES 

The AudioBox USB is a powerful and affordable computer recording system complete with everything 
needed for real-world recording applications.  The AudioBox USB comes complete with two high-
quality PreSonus microphone preamps, MIDI I/O, rock solid drivers, as well as a plethora of music 
recording and production software. 
 
The AudioBox USB includes PreSonus ProPak Software Suite with Cubase LE 4 and over 2 GB of 
plug-ins, drum loops and samples – giving you everything you need for professional music recording 
and production. 
 
Summary of features 
 

• 24-bit / 48k USB audio recording interface 
• 2 class A XMAX microphone / instrument preamplifiers 
• 48V phantom power 
• 2 balanced TRS outputs 
• MIDI input/output 
• Powered via USB 
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1.3  WHAT IS IN THE BOX 

Your AudioBox USB package contains the following: 

 
  

 
• AudioBox USB Recording Interface 

  

  

 

• 6’  USB cable 

  
  

 

• Software installation discs: 
o PreSonus AudioBox USB 

Installation Drivers 
o Cubase LE 4 

 

  
  

 

• PreSonus Warranty Card 

  

  

  
  

 
  



OVERVIEW 
 

 
6 | PreSonus 2008 

1.4  SYSTEM REQUIREMENTS 

Below are the minimum computer system requirements for your AudioBox USB.  
   
Macintosh 
 

• Macintosh OS Mac OS X 10.3.7 or later / 10.4 + / 10.5+ 
• CPU/Clock    PowerPC G4 800MHz (G5 Dual 1GHz or higher recommended) 
• Memory (RAM) 1GB (more recommended) 

 
Windows 
 

• Windows OS Windows XP/ Vista (32 Bit) 
• CPU/Clock Pentium or Athlon 900MHz (1.5 GHz or higher recommended) 
• Memory (RAM) 1GB (more recommended) 

 
 
NOTE:  The speed of your processor, amount of RAM and size & speed of your hard drives will 
greatly affect the overall performance of your recording system.  A more powerful system (faster 
processor with more RAM) allows for lower latency (signal delay) and better overall performance. 
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2.1  QUICK START UP 

2.1.1  Installation in Mac OS X  

The AudioBox USB is a class compliant core audio device.  No driver installation is necessary.  
Simply connect your AudioBox USB to your computer. 

 
2.1.2  Installation in Microsoft Windows  

After inserting the Installation CD into your CD-ROM drive, the AudioBox USB installer will 
take you through each step of the installation process.  Please read each message carefully – 
ensuring especially you do not connect your AudioBox USB early. 

 
  

 

1) The AudioBox USB Installer was written 
to be as simple and easy-to-follow as 
possible. Please read each message 
carefully to ensure the AudioBox USB is 
properly installed. 
 
Before continuing the AudioBox USB 
Installation Setup, please close all 
multimedia applications and disconnect 
your AudioBox USB from your computer. 
 
Once the Welcome screen launches, click 
“Next” 

  
  

 

2) If you see any Windows Security alerts, 
click “Install this driver software 
anyway” (Vista) or “Continue anyway” 
(XP). 

  
  

 

3)    The installer will now show you where the 
drivers for your AudioBox USB will be 
installed.  The installer should 
automatically choose the Program Files 
folder in your System drive.   

 
Click “Next” 
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4)  You will now notify you that the driver will 
now be installed. 

 
Click “Next” 

5)  Congratulations!  You have finished 
installing your AudioBox USB. 

 
Click “Finish” and connect your 
AudioBox USB to your PC. 
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2.1.3  Cubase LE 4 – Device Setup 

Once you have installed the AudioBox USB drivers and connected your AudioBox USB, you can 
use the Cubase LE 4 Music Creation and Production System software included with your 
AudioBox USB to begin recording, mixing and producing your music.  Insert the Cubase LE 4 
installation CD into your computer and run the installer. 
 
Then, launch Cubase LE 4 and follow these steps to begin recording with your AudioBox USB: 

  
  

 

1) Select ‘Device Setup…’ from the Devices menu. 

  
  

 

2) Select ‘VST Audio System’ from the Devices column 
in Device Setup. 

  
  

3) Select ‘AudioBox USB’ from the ASIO Driver 
dropdown list. 
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4) Click ‘Switch’ to begin using the AudioBox USB 
Driver. 

  
  

For more help on using Cubase LE 4, please read the 
Getting Started and Operation Manual help documents 
located in Help > Documentation. 
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2.1.4  Cubase LE 4 – Creating a Project 

To begin recording in Cubase LE, you first need to create a project.  Once you have the project 
environment, you can begin adding audio and MIDI tracks to record and edit on.  Follow these 
simple steps to begin recording your first audio in Cubase LE: 

 
1) Plug an XLR microphone or instrument into AudioBox USB channel one and turn on 48V 

phantom power if needed for your microphone (typically only for condenser microphones.) 
  

 

2) Enter the File menu and select ‘New Project’. 
 

You can also use the keyboard shortcut Ctrl+N. 
  
  

 

3) Select ‘Empty’ when prompted for a Template. 
 

Click ‘OK’. 

  
  

 

4) Right-click in the track space within the new 
project and select ‘Add Audio Track’ from the 
dropdown menu which appears. (You can also 
add a track going to Project>Add Track.) 

 
5) When the Add Audio Track dialogue appears, 

choose the number of Audio Tracks you wish to 
add, whether they will be Mono or Stereo and 
then click ‘OK’. 

 
If you have two audio signals making up a stereo 
pair (i.e. keyboard, FX processor, cd player, 
etc.), you should use a Stereo Configuration. 

 
If you have a single, mono audio source (i.e. 
microphone or instrument), you will want to 
choose a Mono Configuration. 
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9) Turn up the gain control knob on the front panel of the AudioBox USB for channel 1 while 

speaking/singing into the microphone or playing your instrument.  You should see the input 
meter in Cubase LE react to the input.  Adjust the gain so the input level is near its maximum 
without clipping. 

 
10) Connect a set of headphones to the AudioBox USB headphone output.  You may also wish to   

connect monitors to the AudioBox USB’s Main Outs. 
 
11) You are now ready to record. 

 
 

Cubase LE help is available by pressing <F1> on your keyboard or online by visiting 
www.steinberg.net. 

6) Click the Record Enable button to arm the new 
track for recording. 

 
7) Click the Monitor button to hear the input 

through the AudioBox USB’s Main outputs. 
 

8) Select AudioBox USB input ‘Stereo In > Left’. 
 

When choosing a mono from a stereo pair, the 
“left” channel is typically the odd-numbered 
channel, and the “right” channel is typically the 
even-numbered channel (i.e. Left is 1; Right is 2). 

 
Press <F4> on your keyboard to enter the VST 
Connections menu for more details on your 
specific input and output routing. 
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2.2  SAMPLE HOOK UP DIAGRAM 

With the AudioBox USB, you can simultaneously record two tracks at one time.  Since it is loaded 
with two microphone/instrument preamps, you can plug in two microphones to the AudioBox USB or 
one microphone and one instrument (i.e. electric guitar, bass, etc). This makes recording extremely 
easy.  All you need are a couple of microphones, some cables to connect them, a musician (or two) 
and the creative energy to bring it all together. 
 
This is a typical singer/songwriter setup.  Your needs may vary depending upon the variety of sources 
you are recording.  Feel free to adapt the sample setup below to your precise needs. 
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2.3  MICROPHONES 

The AudioBox USB works with many microphones including dynamic, ribbon and condenser 
microphones.  

 
2.3.1  Condenser 

Condenser microphones tend to generate a high-quality audio signal and are one of the most 
popular mic choices for today’s studio recording applications.  Because of their design 
technology, condenser microphones require a power source, which can be provided from a small 
battery, external power supply or from microphone inputs as phantom power.  The AudioBox 
USB sends phantom power over XLR inputs only. 

 
2.3.2  Dynamic 

Dynamic microphones are possibly the most widely used microphone type – especially in live 
shows.  They are relatively inexpensive, resistant to physical damage and typically handle high 
sound pressure levels (SPL) very well.  Unlike condenser microphones, dynamic microphones do 
not require a power source and, in most cases, has no effect on a dynamic microphone’s audio 
quality or sensitivity. 
 
Dynamic microphones, especially ribbon microphones, tend to generate low output voltages, so 
they typically need more preamp gain than a condenser microphone. 
 
Ribbon 
 
Ribbon microphones are a special type of dynamic microphone and get their name from the thin 
metal ribbon used in their design.  Ribbon microphones have very high quality sound reproduction 
qualities – especially higher frequencies sounds.  However, they are very fragile and typically 
cannot handle high SPL’s. 
 
The most important thing to note about Ribbon microphones is that nearly all Ribbon 
Microphones do NOT require phantom power.  In fact, unless a Ribbon microphone specifically 
calls for phantom power, sending phantom power to a ribbon microphone will destroy it – usually 
beyond repair. 
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2.3.3  USB and other types 

There are a vast number of microphone types available, and as technology increases, it is very 
likely more will surface.  One type of microphone to emerge recently is the USB microphone.  
Most USB microphones have their own built-in preamp and use drivers separate from the 
AudioBox USB drivers. 
 
If you are using a new or non-standard type of microphone (i.e., USB, headset, laser, MEMS, 
etc.), please consult your microphone’s user’s manual for power requirement or compatibility 
information. 
 
Regardless of the microphone type you are using, we recommend reading your microphone’s 
user’s manual thoroughly before engaging phantom power or if any other usage questions  arise. 
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3.1  FRONT PANEL LAYOUT 

 
 
 

• Microphone Pre-Amplifier.  Your AudioBox USB is equipped with two custom designed 
PreSonus microphone preamplifiers for use with all types of microphones including Dynamics, 
Condensers and Ribbons as well as instruments and line level signals.  The award winning 
PreSonus preamplifier design is a Class A input buffer followed by a dual servo gain stage.  
This arrangement results in ultra low noise and wide gain control allowing the AudioBox USB 
user to boost desirable signal without increasing unwanted background noise. 

 
o 48 Volt Phantom Power.  The AudioBox USB has 48V Phantom power available for both 

mic preamps via a single push button switch on the front panel.   
 

 XLR connector wiring for Phantom Power 
  

• Pin 1 = GND 
• Pin 2 = +48V 
• Pin 3 = +48V 

 
o Neutrik Combo Connectors.  Both channels of the AudioBox USB have a Mic/Line 

connector using the Neutrik Combo connector. This revolutionary style connector lets you 
use either ¼” phone or XLR connectors in the same female input. Both channels of the 
AudioBox USB are ¼” instrument and microphone XLR inputs.  

 
• Instrument Inputs (Channels 1 and 2).  The ¼” TS connector on channels 1 and 2 are for use 

with an instrument (guitar, bass, etc.). When an instrument is plugged into the instrument input, 
the mic preamp is bypassed, and the AudioBox USB becomes an active instrument preamplifier. 

 
NOTE: Active instruments are those that have an internal preamp or a line level output. Active 
instruments should be plugged into a line input rather than into an instrument input.  Plugging a 
line level source into the instrument inputs on the front of the AudioBox USB not only risks 
damage to these inputs but also results in a very loud and often distorted audio signal. 

 
(In other words, don’t plug a line level source into the combo jacks of channel 1 or 2.) 
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• Input Gain/Trim Control.  These knobs provide the following gain structure: 
 

o XLR Microphone Inputs.    35 dB of variable gain (0 dB to +35 dB) 
o TS ¼” Instrument/Hi-Z Inputs.   35 dB of variable gain (0 dB to +35 dB) 

 
• Clip Indicator.  Both channels feature a clip LED next to the trim control.  The red clip 

indicator LED will illuminate when the channel’s input signal reaches 0 dBFS.  At this level, 
your mic preamp/line trim signal will exhibit signs of clipping such as distortion.  It is highly 
recommended you do not allow your converters to clip (the red clip indicators to light up) as the 
sound quality will not be desirable. 

 
• Mixer.  The Mixer knob allows you to blend your input signal with the playback stream from 

your computer.  This allows you to monitor your input signal zero-latency.  If the knob is 
positioned at 12 o’clock, the input signal and the playback stream will be equally balanced.  
Turning the knob towards the left will increase the level of the input signal relative to the 
playback stream; turning to the right will increase the level of the playback stream relative to 
the input signal.   

 
• Phones.  The Phones knob controls the amount of volume going to the headphone output on the 

front of the unit.  Notice the volume indicator goes to 11: use this setting with extreme caution. 
 
• Main.  The Main knob controls the output level for the Main Outputs on the back of the 

AudioBox USB with a range of -80 db to +4 dB. 
 
• Power Light.  This light indicates the AudioBox USB is receiving bus power. 
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 3.2  BACK PANEL LAYOUT 

 

 
 

• ¼” Headphone Jack.  This is where you connect your headphones to the AudioBox USB. 
 

• Main Output.  This is the main output for your AudioBox USB.  The output level of the Main 
Outputs is controlled by the AudioBox USB Main volume knob on the front of the unit. 

 
• MIDI In and Out Ports.  MIDI stands for “Musical Instrument Digital Interface”.  However, 

the MIDI standard goes well beyond just instrumentation and sequencing.  The MIDI inputs 
and outputs allow connection and/or communication with external MIDI equipment.  One 
function of this port is MIDI programming.  These can also be used for MMC (MIDI Machine 
Control) and MTC (MIDI Time Code). 

 
NOTE:  MIDI is not audio but is frequently used to trigger or control an audio source (such as 

a VST plugin or synthesizer).  When using MIDI, ensure your MIDI data is correctly 
sent and received by the appropriate hardware or software instruments.  You may also 
need to return those devices’ audio to the AudioBox USB.  Please consult the User’s 
Manual of your MIDI devices for help with MIDI setup and usage. 

 
• USB port.  This is where you connect the USB cable from your AudioBox USB to your 

computer.  The AudioBox is completely bus powered from this connection. 
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4.1 SPECIFICATIONS 

Microphone Preamp 
 
Type ............................................................................................................ XLR Female Balanced 
Frequency Response (±3.0 dB) ............................................................................. 14 Hz to 70 kHz 
Input Impedance (Balanced)  .............................................................................................. 1200 Ω 
THD+N (unwtd, 1 kHz @ +4 dBu Output, Unity Gain)  ..................................................  < 0.008% 
EIN (A-weighted, 55dB Gain, 150 Ω Input, 20Hz to 22 kHz)  ......................................... -115 dBu 
S/N Ratio (Unity Gain, Ref. = +4 dBu, 20Hz to 22 kHz)  ................................................... > 95 dB 
Common Mode Rejection Ratio (1 kHz, 55 dB Gain)  ......................................................... > 45 dB 
Gain Control Range (± 1dB) .................................................................................... 0 dB to 35 dB 
Max Input Level (Unity Gain, 1 kHz @ 0.5% THD+N)  ....................................................... -3 dBu 
Phantom Power (±2 VDC)  ..............................................................................................+48 VDC 
 
Instrument Input  
 
Type  ........................................................................................................................................ ¼”  
TRS Female Unbalanced Input Impedance  ......................................................................... 0.5 MΩ 
 
Line Outputs  
 
Type  ................................................................................................................................ ¼” TRS  
Balanced Output Impedance  .................................................................................................. 51 Ω 
 
Headphone Output 
 
Type  ........................................................................................................... ¼” TRS Active Stereo 
Maximum Output  .................................................................................... 60 mW/Ch @ 60 Ω Load 
Frequency Response (±1.0 dB)  .............................................................................. 20 Hz – 30 kHz 
 
MIDI I/O   
 
Type  ......................................................................................................... Dual 5-pin Female DIN 
 
Digital Audio 
 
ADC Dynamic Range (Awtd, 48 kHz Sample Rate)  ............................................................ 102 dB 
DAC Dynamic Range (Awtd, 48 kHz Sample Rate)  ............................................................ 110 dB 
Bit Depth  .................................................................................................................................. 24 
Reference Level for 0dBFS  .................................................................................................+4 dBu 
Internal Sample Frequency Selections (kHz)  ..................................................................... 44.1, 48 
 
 
As  a  commi tment  to  c ons t an t  improvement ,  PreSonus  Aud io  E l ec t ron i c s ,  I nc .  
r e s er ve s  the  r i gh t  t o  change  any  spec i f i ca t i on  s ta t ed  he r e in  a t  any  t ime  
w i thou t  no t i f i ca t i on .  
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